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Mobile App Development 
● A mobile application is a software application designed to run on 

smartphones, tablet computers and other mobile devices. 
● Users on smartphones typically check the news, weather, email 

or their social networks. They have a choice between the mobile 
web version or a specially-created mobile app. 
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Mobile App Dev: Current State 

Native Development Crossplatform Development

● Android - Kotlin or Java
● iOS - Swift or Objective C

● Flutter - Dart - Bridge to 
native code (bring out native 
element) - 3 tahun - 1 code 
for all platform (android, ios, 
web, desktop..)

● React Native / ReactJs - JS - 
Bridge to native code (bring 
out native element) , stable 
2017, instagram, facebook, 
facebook messenger

● Ionic - JS - Webview
● Xamarin - .NET



Mobile App 
Types 

● Native 
○ Programmed using Swift/Objective C on the iPhone or 

using Java/Kotlin on Android devices. 

● Hybrid 
○ Mix between these two types of mobile applications.
○ Normally based on web programming language, eg: HTML, 

CSS, Javascript, Dart
○ Built once to be run on Android and iOS.

● Web Apps / Progressive Web Apps. (selangkah) -> 
(Add to home screen)

○ Web based.
Runs in the phone’s browser. 

○ Can have native features based on HTML5
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What is Flutter
Open source UI Framework by Google

Able to create iOS, Android and web application 
using Dart

High performance, high fidelity, low latency, as it 
renders the Native UI. 

Use DART as main programming language

Open source / github. 



About Dart
Dart is a programming language developed by 
Google 

Learning it isn’t hard if you have experience with 
Java or JavaScript. You will quickly get it.

You can use dartpad as an online compiler of Dart

https://dartpad.dev/

https://dartpad.dev/


Who uses Flutter

https://flutter.dev/showcase

https://flutter.dev/showcase


 Malaysia Google Trend (over 5 years)



Bridge gap between designer and developer - XD Flutter integration



Bridge gap between designer and developer - Supernova io



Setup your Editor

https://flutter.dev/docs/get-started/editor

You will need to configure an emulator after setting up the SDK.

https://flutter.dev/docs/get-started/editor?tab=androidstudio


Setting up Android Studio
1) Create New Project -> Select empty project -> Next -> Finish. Wait until 

gradle sync successfully
2) Select AVD Manager, Select a device (with Google Play logo), Download & 

Install OS (recommended Q and Above) -> Next (Finish)
3) Once AVD created, press Play 
4) Select Run



Setting up Flutter
1) Go to Flutter.dev -> Docs -> Getting started
2) Select your OS and Download the installer file
3) Unzip the installer folder to a proper folder
4) Install Android Studio Flutter plugin 

a) File -> Settings -> Plugins -> Flutter
b) A pop up will appear for confirmation to install Dart as well. Select Yes
c) Restart IDE

Upon restart new menu will appear Start new Flutter project



Native vs Crossplatform
Native Crossplatform

2 code base
- iOS
- Android

1 codebase
- Use the same code to compile in iOS 

and Android respectively

4  bulan ⅔ to ¾ of native time..

Stable.. This is the main source of truth Not as stable as native.. A bridge to 
native.. If ios…., if android ...
 (library) Android -> file folder, ios no file..

Matured.. Already there since 2009
A lot of people and advocate, more 
questions answered in Stackoverflow
Eg: Android Certified Developer, Google 
Expert (Android), Google Advocate. (work 
for google or partner)

New, between 3-5 years
Not as much user as Native...

Initial project cost: RM 100 000 Initial project cost:RM 60 000 - 75 000

Maintenance - cheaper Maintenance higher than native, due to it is 
not fully stable, and you might need to 
update the code from time to time 

You can use the latest technology,  new 
things - widget on home screen, face id 
with mask

You need to wait until somebody create the 
bridge code (pub.dev)

Easy to Access kernel / hardware layer
(security/ cryptography)

Normally in Application layer..

If your app is for 
- Long term
- More than xxx xxx MAU (
- Have budgets ….
- Need to use complex device features
- Something that is compulsory 

(stability)
- TNB, MySejahtera, UiTM registration 

LMS, AirAsia, Firefly
- App become a new channel

If your app is:
- Created in the fastest time..
- Just use simple device features..
- Limited budget…
- Not many people accessing it..
- App is a new business (Minimum 

Viable Product)



Getting started with Flutter
1) Create Flutter project 
2) Point to flutter sdk
3) Add package name = reverse DNS + application name





The boilerplate code of an app - Scaffold
Scaffold(

      appBar: AppBar(

        title: const Text('Sample Code'),

      ),

      body: Center(child: Text('Hello World')),

      floatingActionButton: FloatingActionButton(

        onPressed: () => {},

        tooltip: 'Increment Counter',

        child: const Icon(Icons.add),

      ),

    );



Scaffold
A scaffold is a basic structure of an application having the following property by 
default:

● appbar
● body
● floatingActionButton
● bottomNavigationBar
● drawer



Everything is a widget
You build widget upon widget.

Your screen, a section in a screen, a tiny little section is 
also a Widget.

You create and customize your own widget.



Widget catalog

https://flutter.dev/docs/development/ui/widgets

https://flutter.dev/docs/development/ui/widgets


Widgets for layouting
We will discover the widgets that are used to position items within a page. Here 
are some important/main widgets:

● Container
● Center
● Column
● Row
● SingleChildScrollView



Container

Center(

  child: Container(

    margin:  EdgeInsets.all(10.0),

    color: Colors.amber[600],

    width: 48.0,

    height: 48.0,

   padding:EdgeInsets.all(10.0)

  ),

)

A container is a box! You can specify the width, height, color, padding and margin. 
In the below example, EdgeInsets.all means all direction (top, bottom, left, right)



Center
A widget that centers its child within itself.

Center(child: Text('Hello World')),



Row
A widget that displays its children in a horizontal array.

Row(
  children: <Widget>[
    Expanded(
      child: Text('Deliver features faster', textAlign: 
TextAlign.center),
    ),
    Expanded(
      child: Text('Craft beautiful UIs', textAlign: 
TextAlign.center),
    ),
    Expanded(
      child: FittedBox(
        fit: BoxFit.contain, 
        child: const FlutterLogo(),
      ),
    ),
  ],



Column
A widget that displays its children in a vertical 
array.

Column(
  children: <Widget>[
    Text('Deliver features faster'),
    Text('Craft beautiful UIs'),
    Expanded(
      child: FittedBox(
        fit: BoxFit.contain, 
        child: const FlutterLogo(),
      ),
    ),
  ],
)



SingleChildScrollView
A box  which allows a single widget to be scrolled.

You will use this when you have a single box that will normally be 
entirely visible, for example a clock face in a time picker, but you need 
to make sure it can be scrolled if the container gets too small in one 
axis 



Center, Container Row and Column

Have 1 child only Can have more than one child (children)

child children

Call Widget directly Put widget inside Array []

<Widget> - of type



Visible widget in Flutter
Once you know how to position items on a page, we will see some of the widgets 
that you can use in your application. Here are some important/main widgets:

● Text
● Image
● Button
● Icon
● Slider



Text
Text(

  'Hello World',

  textAlign: TextAlign.center,

  style: TextStyle(fontWeight: FontWeight.bold, 
color:Colors.red),

),

This widget is used to displays a text with 
single style. 

You might need to use TextStyle widget as 
well with this widget to add styling to the 
text, for example to add color, set to bold



Image

Image(

  image: 
NetworkImage('https://flutter.github.io/assets-for-api
-docs/assets/widgets/owl.jpg'),

)

To show an image. You may show an image 
from:

● Downloaded from a URL 
(Image.network)

● Stored locally in assets folder 
(Image.assets)



RaisedButton 

RaisedButton(

                child: Text('Color Changed'),

                color: Colors.green,

                onPressed: () {

print(“Hello World”)},

              ),

A raised button, follows Material 
design principle is a button that 
raises slightly, configurable via 
elevation property.

You will need to declare what 
should happen when the button is 
pressed via it’s onPress property.

Other type of button includes 
FlatButton



Icon
Icon(

      Icons.audiotrack,

      color: Colors.green,

      size: 30.0,

    ),

As per its name, an icon is a widget that is 
predefined, and can be used directly within 
your application.

You may refer to Icon documentation, to see 
all available icon ready to be used in your 
application

https://api.flutter.dev/flutter/material/Icons-class.html

https://api.flutter.dev/flutter/material/Icons-class.html


Slider
Slider(
value: _value.toDouble(),
min: 1.0,
max: 10.0,
onChanged: (double newValue) {
setState(() {
_value = newValue.round();
});
},

A slider can be used to select 
from either a continuous or a 
discrete set of values. 

We will use onChanged property 
to update the value of item, once 
the value of slider changed.



Visible widget in Flutter
Once you know how to position items on a page, we will see some of the widgets 
that you can use in your application. Here are some important/main widgets:

● Text
● Image
● Button
● Icon
● Slider



Text
Text(

  'Hello World',

  textAlign: TextAlign.center,

  style: TextStyle(fontWeight: FontWeight.bold, 
color:Colors.red),

),

This widget is used to displays a text with 
single style. 

You might need to use TextStyle widget as 
well with this widget to add styling to the 
text, for example to add color, set to bold



Image

Image(

  image: 
NetworkImage('https://flutter.github.io/assets-for-api
-docs/assets/widgets/owl.jpg'),

)

To show an image. You may show an image 
from:

● Downloaded from a URL
● Stored locally in assets folder



Icon
Icon(

      Icons.audiotrack,

      color: Colors.green,

      size: 30.0,

    ),

As per its name, an icon is a widget that is 
predefined, and can be used directly within 
your application.

You may refer to Icon documentation, to see 
all available icon ready to be used in your 
application

https://api.flutter.dev/flutter/material/Icons-class.html

https://api.flutter.dev/flutter/material/Icons-class.html


RaisedButton 

RaisedButton(

                child: Text('Color Changed'),

                color: Colors.green,

                onPressed: () {

print(“Hello World”)},

              ),

A raised button, follows Material 
design principle is a button that 
raises slightly, configurable via 
elevation property.

You will need to declare what 
should happen when the button is 
pressed via it’s onPress property.

Other type of button includes 
FlatButton



Slider
Slider(
value: _value.toDouble(),
min: 1.0,
max: 10.0,
onChanged: (double newValue) {
setState(() {
_value = newValue.round();
});
},

A slider can be used to select 
from either a continuous or a 
discrete set of values. 

We will use onChanged property 
to update the value of item, once 
the value of slider changed.



Styling attributes
● Text - > style : TextStyle(color , fontSize, fontFamily )
● FlatButton, RaisedButton -> color, textColor
● Scaffold - > backgroundColor -> Change background color of the page

You can use Colors.green (Color name) or use ARGB Color.fromARGB() when 
defining color in the style.

For changing font, refer to the manual, there is an example to load font from 
Google Font. It will involve changing pubspec.yaml



pubspec.yaml
Define the sdk version (no need to change)

Define the dependencies (get it from pub.dev)





Add new library
1) Go to pub.dev
2) Look for the library of choice (Make sure support iOS/Android) and good 

rating + maintained
3) Copy the code
4) And put inside pubspec.yaml under dependencies. Verify the identaton is 

correct.



Stateful
Widget that manipulate data:

1) Normally page with form 
(TextInput, Slider..) is 
stateful, if you need to use 
setState in that page

2) page with API call is 
stateful, unless you are 
using StreamBuilder.

stful + tab -> Create a stateful 
widget

Stateless
Only to show UI and constant - 
About Us page..

stless + tab (Create a stateless 
widget)





Demo - BMI Calculator



Demo
We will create a simple BMI calculator app that will calculate BMI based on height 
and weight entered by user.

● An application using stateful widget since we are storing height, weight and 
bmi

● Create the structure using scafffold
● Add Scrollview and container
● The container will contain a Column with:

○ Image (logo of our app)
○ App title and subtitle 

● Two containers containing slider for user to choose height and weight
● Button  when the button is pressed you will do the BMI calculation



Best practice when creating files
1) Create a new package, call it widgets
2) Create all widgets file (UI) inside components folder ..
3) You may also have different package for each widgets as you might have 

multiple files in one page



Creating a ListView



Step creating a ListView
1) Get the reference from : https://api.flutter.dev/flutter/widgets/ListView-class.html

2) Create the Data source , in our case, we built a List of names
3) Get the second code from documentation, there are two important items:

a) itemCount : How many rows are there? Normally it is the length of your List created in #2
b) itemBuilder : What to show on each row

https://api.flutter.dev/flutter/widgets/ListView-class.html


ListTile
To facilitate the creation of List, you 
hava access to ListTile, a component 
that help you to create row , and by 
default will have:

● Title
● Subtitle
● Leading
● Trailing
● onTap

https://api.flutter.dev/flutter/material/ListTile-cl
ass.html

https://api.flutter.dev/flutter/material/ListTile-class.html
https://api.flutter.dev/flutter/material/ListTile-class.html


Navigation to a new screen
1) Create a new page, inside widget folders, call it add.dart and detail.dart
2) Inside the new page create a simple UI (Scaffold and Container body)
3) In the first page, for example upon button pressed create the code to open the 

second page as follows:

https://flutter.dev/docs/cookbook/navigation/navigation-basics

https://flutter.dev/docs/cookbook/navigation/navigation-basics


Passing data to second page
1) In second page (receiver) create a variable where you will retrieve the data
2) Create constructor with data retrieved in parameter.
3) Go back to first page, pass the data



Passing data from second page to first page (1)
1) In the first page, (receiver) open the second page but this time you will add 

keyword async await indicating that you are waiting result from second page.

2) On second page, (sender), you will pass back the item using navigation.pop 
method, and pass it in the second parameter.



Passing data from second page to first page (2)
3) Retrieve the data and perform operation with the data.



Adding form in Flutter (TextField)
1) Create a TextField, and customized the textfield , Eg : Adding InputDecoration 

hint
2) For each textField, add TextEditingController and link it to each textfields.
3) Upon onPress for Example, retrieve the text entered by user by referring to 

the text property of the TextEditingController

https://api.flutter.dev/flutter/material/TextField-class.html

https://api.flutter.dev/flutter/material/TextField-class.html


Storing Data
Locally

1) File -https://flutter.dev/docs/cookbook/persistence/reading-writing-files

2) Shared Preference : https://flutter.dev/docs/cookbook/persistence/key-value

3) Sqlite: https://flutter.dev/docs/cookbook/persistence/sqlite

4) Sqlite via Moor : https://medium.com/flutterdevs/moor-database-in-flutter-6a78d91b10e5

Remotely

1) REST API
2) Firebase

https://flutter.dev/docs/cookbook/persistence/reading-writing-files
https://flutter.dev/docs/cookbook/persistence/key-value
https://flutter.dev/docs/cookbook/persistence/sqlite
https://medium.com/flutterdevs/moor-database-in-flutter-6a78d91b10e5


Android
(Sqlite, 
Room 
Architect
ure)

iOS

Database 
(MySQL, 
MongoDB, 
Oracle)

Application 
Programming 
Interface
(Middleware)

RESTful
JSON/XML

{
name:”Muzaffar”,
email:”wanmuz86@gmail.com”
}

<user>
<name>Muzaffar</name>
<email>wanmuz86@gmail.com</em
ail>
</user>

CMS -Content 
Management 
System

Payment
Push notification
Email
Image Recognition from 
Faculty AI/ Wise.ai

Front end website - 
SPA (Single Page 
Application)
 VueJS, React, Angular

mailto:wanmuz86@gmail.com


http://www.omdbapi.com/?s=Harry&apikey=87d10179
http://www.omdbapi.com/?i=tt1201607&apikey=87d10179

http://www.omdbapi.com/?s=Harry&apikey=87d10179
http://www.omdbapi.com/?i=tt1201607&apikey=87d10179


List of movies

Enter a movie Search

Poster

Film title
Plot
Directors
Actors ..



Create Model class (representing JSON)



Create fromJSON function to transform JSON to 
Model



Create List<Array> transformation methods



FetchFilms function
Future<List<Film>> fetchFilms() async {

 final response = await http.get('https://www.omdbapi.com/?s=Inception&apikey=87d10179');

 if (response.statusCode == 200) {

   return Film.filmsFromJson(json.decode(response.body));

 } else {

   // If the server did not return a 200 OK response,

   // then throw an exception.

   throw Exception('Failed to load album');

 }

}



Python JS

Computer Science x x

Web X (Flask, Django) X (React JS, VueJS

App / Mobile X (React Native)

Data Science x

IOT X (Rasperi Pi/ Arduino)

DB X (Mongo DB)

https://insights.stackoverflow.com/survey/2020



email

password

Login

No account? Sign up

Forgot password

email

password

Register

email

Reset password

AAA
marketing

BBB
IT

CCC
IT

Enter message Send

AAA - 12.15 pm 
Jom Makan 

BBB- 12.15 pm 
Jom! Makan mana?



Adding firebase in project

1) Go to firebase.google.com, add a project there, 
press add (on or off google analytics)

2) Add the google-services.json file into the app root 
folder

3) Follow the instruction



In case you forget your application id, this is where you find









Pub dev

1) Install Firebase Authentication, 
cloud firestore and Firebase Core



Initalize Firebase app ( add this in main file)
// Add the import

import 'package:firebase_core/firebase_core.dart';

void main() async {

// Add these two lines

 WidgetsFlutterBinding.ensureInitialized();

 await Firebase.initializeApp();

 runApp(MyApp());

}



Firebase Authentication

For all the page that is going to use Firebase Authentication , 
: login, register, forget password, you will add the 1st line 
everytime

1) Initialize Firebase Authentication Instance

var _auth = FirebaseAuth.instance;

2) Add code to createUser (as next page)



Code to createUser
User user =

   (await _auth.createUserWithEmailAndPassword(email: email,

       password: password))

       .user;

if (user != null){

 print("Succesfully logged in");

}

else {

 print("Something is wrong!");

}



Before testing you need to go to firebase 
authentication console, and enable firebase 
authentication



Sign in code
User user = (await _auth.signInWithEmailAndPassword(

       email: emailEditingController.text,

       password: passwordEditingController.text))

   .user;

print(user);

if (user != null) {

 print("Succesfully logged in!");

 Navigator.push(context, MaterialPageRoute(builder: (context)=>ChatList()));

} else {

 print("Error");

}





Setup firestore

1) Initialize Firestore Instance
2) Add multiDexEnabled inside app level build.gradle (refer next 

page)
3) Call the methods : 

a) Add/ Create = setData





Firestore permission
rules_version = '2';

service cloud.firestore {

  match /databases/{database}/documents {

    match /{document=**} {

      allow read, write: if

          request.time < timestamp.date(2020, 10, 3);

    }

  }

}



Example - Creating a users collection after user 
succesfully registered
import 'package:cloud_firestore/cloud_firestore.dart';

..

var user = value.user!;

FirebaseFirestore.instance.collection('users').doc(user.uid).set({

 'email':user.email,

 'id':user.uid,

 'createdAt':DateTime.now(),

 'chattingWith':null

});





1) Create the userId and constructor, I need to know 
who is currently logging in



2) Get the data and show it in the ListView

StreamBuilder<QuerySnapshot>(
   stream: 
FirebaseFirestore.instance.collection('users').
snapshots(),
   builder: (context, snapshot) {
     if (!snapshot.hasData) {
       return CircularProgressIndicator();
     } else {
       final List<DocumentSnapshot> documents =
           snapshot.requireData.docs;
       return ListView.builder(
           itemCount: documents.length,
           itemBuilder: (context, position) {
             if (documents[position]["id"] != 
widget.userId) {
               return ListTile(
                 title: 
Text(documents[position]["email"]),
               );
             } else {
               return Container();
             }
           });
     }
   }
   )

https://dev.to/kazuhideoki/how-to-g
et-data-from-firestore-and-show-it-o
n-flutterbuilder-or-streambuilder-e0
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3) Pass the userId from Login page to Employee List



4) Create an onTap that will open the new page



1) Create the channel ID



2) Code to chat (save/pass data to firebase)





5) Retrieve the chat, and show the message



/main

fo

head

main

footer

fo

head

detail

footer

/detail



6) Modify your code to show the sender email ...
Later verify with my source code



Inside profile, you need current UserId, create the 
textediting controller as well



This is the code to get the data and assign it to the 
controller



Call the method created on initState





1) Complete the rest code for update profile, include phone number and address 
profile update (compulsary)

2) Add a View Profile page, for example on the top right of chat pagem you can 
have a view profile page that will bring you to your friend’s profile page 
showing his or her info

If you want to do more, use this tutorial, which I simplified to teach you:

https://medium.com/flutter-community/building-a-chat-app-with-flutter-and-firebase
-from-scratch-9eaa7f41782e


